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About the EPSON Stylus series printing system

 Welcome to the EPSON® Stylus™ series printing system, where printing is fast and effortless and your 
output is customized for all your printing needs. 

The EPSON Stylus series printing system is installed the same way as any other Microsoft® Windows™ 
printer driver, but has some major advantages over the conventional Windows technology:

The printer driver includes on-screen examples of how your images will print as you change the 
printer driver settings.

The printer driver screen is divided by simple-to-use tabs that follow the graphic style of Windows.
The software release time is much quicker than conventional printer drivers, even when you use 

sophisticated print settings, such as diffusion.
Colors are richer and truer to the screen image due to the printer drivers automatic color 

adjustment settings for screen-to-printer WYSIWYG.
Photographs look realistic and graphics are smoother because of the drivers advanced diffusion 

halftoning and MicroWeave features.
Print time is generally significantly shorter than with other ink jet printers, even when the driver is 

processing color images or interfacing with advanced 24-bit per pixel devices.

In addition, you can use a wide variety of printer driver options to create fantastic printed images without 
sacrificing overall system performance.

See also

Technical Description



EPSON Stylus Printing System

The EPSON Stylus series printing system consists of a number of distinct elements:

The Printer Driver(s) for the EPSON Stylus series printer.
The EPSON Spool Manager.
The EPSON Despooler.
Supporting files.

These elements work together to provide an optimum printing environment for your EPSON Stylus printer.



EPSON Stylus Printer Driver

The printer driver is usually accessed through your softwares Printer Setup option or from the Printers 
icon of the Microsoft Windows Control Panel.

The printer driver allows your computer to use all of the features and capabilities of your EPSON Stylus 
printer.



Release Time

This is the time that it takes for control to return to you from the Print option within your application.

The EPSON Stylus series printing system returns you to your application quickly so that you can continue
working while your printing completes in background.



WYSIWYG

What You See Is What You Get.    Generally with the EPSON Stylus series printing system, what you see 
on the screen is what you get on the printer in terms of colors, image size, print density etc.



Diffusion

Most printing systems use dithering to represent an image, which can give quite a grainy result.    The 
EPSON Stylus series printing system supports diffusion printing and uses an advanced rendering 
technique to generate a smoother image.    Graduated fills look better, images look clearer and 
photographs look much closer to the original.

With very complex images, diffusion printing can sometimes take a little longer than dithering but 
generally the results are well worth it.    You will have to experiment with the halftone that best suits the 
picture that you are printing.



Dithering

When images are printed using the dithering selections from the halftoning tab, the EPSON Stylus series 
printing system uses a matrix of dots to represent the image.    This is in common with other Windows 
printer drivers.    You will have to experiment with the halftone method that best suits the picture you are 
printing. The diffusion setting should give the best results in the majority of cases.



MicroWeave

When MicroWeave is selected, the EPSON Stylus printer driver enhances the quality of printed images. 
This is done by passing the print head over the page multiple times, laying down parts of the image on 
each pass. This technique reduces unwanted banding in images.

Images printed by other ink jet printers often have distracting horizontal bands that appear darker or 
lighter than the rest of the image. With the MicroWeave option turned on, these bands in images are 
minimized and your EPSON Stylus output looks truly professional. MicroWeave does not affect text 
output quality.

Since MicroWeave requires several passes during printing, output is slower for monochrome printing. To 
save time you should use it only for presentation quality images.

MicroWeave does not affect color printing speed significantly so you should use it for all color printing.



High Speed

When High Speed is selected, the EPSON Stylus printer driver passes the print head over the page both 
left-to-right and right-to-left (bi-directional print head motion). If High Speed is not selected, printing is uni-
directional and slower, but graphics print quality may be slightly higher.

If you notice that print quality declines when High Speed is selected, you may need to calibrate your 
printer. Use the calibration utility CALIBRAT.EXE included on your driver disk. See the attached README
file for details.

Note:

These two print modes can be selected independently of one another. You need to experiment with these 
settings on your printer to determine the best combination for your printing needs.



The EPSON Stylus printing system - a technical description

If you are familiar with the operation of Microsoft® Windows™ , you might want to read this technical 
description of the features of your EPSON Stylus series printing system.

The EPSON Stylus series printing system is an advanced Windows GDI-style software printing system 
that operates as follows:

The printer driver tells the application that the printer is a raster device but that it can render the 
entire image in a single band. The driver also reports that certain advanced printing options are 
supported. All of these special capabilities save the application from doing extra work and avoid replaying 
the image multiple times.

The GDI commands necessary to represent the image are encoded into an optimized journal file. 
The application releases your computer when the generation of the journal file is completed. Compared to
the spool files generated by standard Windows drivers, journal files are very compact and are the same 
size, no matter what you are printing in color or monochrome. The journal file allows the entire document 
to be replayed to simulate multiple hardware copies or to provide last-to-first print options.

The EPSON Spool Manager initiates the EPSON Despooler, which replays the journal file back to
the driver for the target device. These programs use a highly efficient tasking system to ensure minimum 
impact on your application software.



Windows GDI

Graphics Device Interface (GDI).    This is the part of the Microsoft Windows environment that allows 
programmers to draw lines, circles, polygons, text and control other graphics elements on the output 
device (screen, printer, plotter etc.).



Using the EPSON Stylus series printing system

The following sections tell you how to use the EPSON Stylus series printer driver and the EPSON Spool 
Manager.

Printer Driver

The EPSON Spool Manager



Printer Driver

The EPSON Stylus series printing system provides many automatic features and default settings that take
the guesswork out of printing a wide variety of documents on your ink jet printer. The printer driver 
interface includes easy-to-use tabs and dialog boxes so you can quickly locate all the available settings.

You can access the EPSON Stylus printer driver through your applications Print Setup option (or Print, 
then Setup option) or through the Windows Control Panel by selecting the Printers option.

The following setting types are available as tabs in the printer driver:

Document Type

Paper

Printing Mode/Options

Image Settings

Halftoning

About



Paper

The Paper tab contains settings that allow you to specify the following:

Size of the paper you loaded
Orientation of the printed image
Source from which the printer will feed the paper
Number of copies
Whether multiple copies are collated
Whether pages are printed in reverse order.

Paper Size

Orientation

Paper Source

Copies

See Also
OK Button, Cancel Button,  Defaults Button



Paper Size

In the Paper Size box, select the paper size that you loaded in the printer. Use the scroll bar to locate one 
of the predefined paper sizes or create a custom size. As you move through the options, the example box 
below changes to display the current paper size, orientation, and printable area (indicated by the dotted 
lines).

Use one of the Centered paper sizes only if you want the image to be centered on the page and your 
software program does not have a setting that lets you do this. Centered images have a slightly smaller 
printable area.

If you select User Defined, you can create a custom paper size in the pop up box that appears beneath 
the Paper Size box. Change the current Paper Width and Paper Height settings to the values you want.

Note:
On the EPSON Stylus 800+ printer, smaller paper sizes and envelopes must be fed into the printer 
manually using the Manual feed slot.



Orientation

Select either the Portrait or Landscape button to specify the orientation of the image on the page. 
Normally you should select the page orientation from the Print dialog box in your software application, not 
with the driver. However, you may need to use it to select the correct orientation for envelopes.

To confirm the correct orientation for envelopes, select the envelope in the Paper Size box and check the 
example paper size below the box before you select either Portrait or Landscape.

Portrait

In portrait orientation, the top of the page is parallel with the short edge of the paper.

Landscape

In landscape orientation, the top of the page is parallel with the long edge of the paper.



Paper Source

The EPSON Stylus series printers have different paper sources from which the printer feeds paper. Select
the feeding method you want to use from the Paper Source drop-down list.

Note:
You may not be able to select a different paper source, depending on your printer model.

Note:
On the EPSON Stylus 800+ printer, smaller paper sizes and envelopes must be fed into the printer 
manually using the Manual feed slot.



Copies

Normally you should select these three settings from the Print dialog box in your software program, not 
with the driver. Be sure you do not choose multiple copies in both the Print dialog box and the driver.

Copies

Enter the number of copies you want to print.

Collate

Turn on this function if you selected multiple copies and want all pages of one copy printed before the 
next copy is printed.

Reverse Page Order

Turn on this function is you want to print the last page of your document first and the first page last 
(commonly called last-to-first printing).



Journal File

The EPSON Stylus series printing system generates a compact journal file that contains a complete 
description of your print job in a form that can be processed easily.    This journal file is similar to a tape 
recording in that it can be played, replayed, and rewound in order to process your print job.



Ink
Specifies Color (CMYK) or Monochrome printing. CMYK refers to the printer's colored inks: cyan (blue-
green), magenta, yellow, and black (K). These colors are combined to form any of 16 million colors. When
you select Monochrome, the printer prints only black ink. If you are printing a color image and 
Monochrome is selected, the printer converts color data to grayscale values.

On the EPSON Stylus COLOR IIs, select Monochrome Head Unit to print in monochrome or Color Head 
Unit to print in color. Be sure you have the indicated print head installed.



Halftoning

You achieve the best halftoning results when you let the printer driver's Document Type setting select the 
appropriate halftone method. If you select the Automatic document type option, the driver determines 
which type of halftoning to use based on the data contained on each page in your document. 

If you select one of the other document types, the driver chooses a predefined halftone setting. If you 
change a predefined halftone setting, the driver erases the selected Document Type option and uses the 
halftone setting you selected.

The Halftone options available depend on the printer model you have, as defined below.

Note:

It is recommended that you set Halftoning in the driver rather than setting the halftone or dithering options
in your software.

If you prefer to set the halftoning method manually, follow these guidelines:

All models:

Use No halftoning to speed printing for text or monochrome line art. Do not use No halftoning when 
printing in color.

Stylus Pro/ProXL, Stylus COLOR II, Stylus COLOR IIs, Stylus 820 options:

Error Diffusion is best for photographic images. It creates color by randomly distributing the dots, making
edges and colors softer. It takes longer to print, but it produces the best print quality for photographic 
images.

Dithering A and Dithering B arrange dots in orderly patterns. The dithering method is relatively fast and 
is best suited for printing charts, graphs, and other images that require precise, solid areas of bright 
colors. Use Dithering B for images with significant detail but limited shading. Select Dithering A for images
with limited detail and shading.

Stylus COLOR and Stylus 800+ options:

Line art pattern is best for printing simple line art and computer graphics.



Fine dither pattern and Coarse dither pattern arrange dots in orderly patterns. The dithering method is 
relatively fast and is best suited for printing charts, graphs, and other images that require precise, solid 
areas of bright colors. Use Fine dither pattern for images with significant detail but limited shading. Select 
Coarse dither pattern for images with limited detail and shading.

Diffused (High Speed) is a fast halftone setting for use with less detailed images.

Diffused (Images) is best for photographic images. It creates color by randomly distributing the dots, 
making edges and colors softer. It takes longer to print, but it produces the best print quality for 
photographic images.

Diffused (Complex Diagrams) is best for detailed diagrams or drawings produced by computer drawing 
programs.

See also
OK Button, Cancel Button,  Defaults Button



Printing Mode/Options

The Printing Mode/Options settings let you define the Printing Mode (resolution), Media Type, and Print 
Options for your document. The following table shows how these settings are related to each other and 
which options are available in the different modes.

Printing Mode Media Type
setting setting Default Print Options *

----------------------------------------------------------------------------------------------------------------------

Super - 720 dpi Special coated paper for 720 dpi MicroWeave On
High Speed Off

High quality glossy paper MicroWeave On
High Speed Off

Plain paper MicroWeave On
High Speed Off

---------------------------------------------------------------------------------------------------------------------

Best - 360 dpi Special coated paper for 360 dpi MicroWeave On
High Speed Off

Special coated paper for 720 dpi MicroWeave On
High Speed Off

Plain paper MicroWeave Off
High Speed On

Transparency MicroWeave On
High Speed Off

------------------------------------------------------------------------------------------------------------------

Draft - 180 dpi Plain paper MicroWeave Off
High Speed On

------------------------------------------------------------------------------------------------------------------

*    You may not be able to change these options to a setting other than the default setting.

Be sure to select the Printing Mode before the Media Type.

See also

Printing Mode, Media Type, Print Options, OK Button, Cancel Button,  Defaults Button 



Image Settings

The Image Settings options allow you to adjust the Brightness, Contrast, and Color Matching features of 
your printed images. 

It is best to allow the printer driver's Automatic Document Type setting to select the appropriate image 
settings for you. However, if your original image is of poor quality, you can adjust the image settings to 
improve the printed output.

To help you decide on the best settings, a preview of a sample image appears in the Image Settings 
dialog box. As you change settings, the preview image reflects the options you choose.

If you want to change the sample image to another bitmap (.BMP) image file, double-click on the preview 
image area. Then, in the Change Image Control Bitmap File dialog box that appears, select any other 
bitmap file you may have. The image must be a 1-, 4-, or 8-bit per pixel bitmap format. If the image size is
different from the original sample, it may appear small or not display completely in the preview image 
area.

Brightness

Controls the lightness or darkness of an image. Increase brightness to lighten an image; decrease it to 
darken an image.

Contrast

Controls the degree of difference between the light and dark areas of an image. When you increase 
contrast, the light areas become very light and the dark areas become very dark. When you decrease 
contrast, the difference in intensity is more muted, making the whites and bright colors appear slightly 
gray and the blacks appear very dark gray.

See also

Color Matching, OK Button, Cancel Button, Defaults Button



About

The About tab gives you information about your version of the EPSON Stylus series printer driver, and 
trademark and copyright information.

If you need technical support for the EPSON Stylus series printing system, it is a good idea to make a 
note of the version information on this tab before you call.



EPSON Spool Manager

When you print a document, the printer uses the EPSON Spool Manager to send data to the printer. This 
allows you to continue working in your software program while printing.

When you send a print job to the printer, the EPSON Despooler window appears in the bottom right 
corner of your screen and an icon for the EPSON Spool Manager appears in the lower left corner.

Note:
You may not see the EPSON Spool Manager icon if the Windows Program Manager window is 
maximized. Reduce the Program Manager window size to see it.

When the EPSON Stylus series printer driver releases your application software from printing, a journal 
file is created in the default spool directory. The EPSON Spool Manager is notified that the journal file 
exists and assigns it to the appropriate print queue. When the journal file comes to the front of the queue, 
the Spool Manager submits it to the EPSON Despooler and sends it to your printer.

The Spool Manager gives you control over the EPSON Despooler, the print queues, and the journal files, 
and also allows you to enable remote network printing.

EPSON Spool Manager Window.

EPSON Despooler



Default Spool Directory

The default directory that journal files are sent to is normally specified by the DOS environment string SET
TEMP=.

If you want to alter this you can do so by selecting the Default Spool Directory item from the Options 
menu in the EPSON Spool Manager.



EPSON Spool Manager Window

The Spool Manager window displays the list of print queues and journals that are currently printing or are 
waiting to be printed.

Queues

Queues shown in normal intensity represent printers that are supported by the EPSON Stylus series 
printer driver. Queues shown in low intensity are supported by other Windows printer drivers.

You can change options for EPSON Stylus series print queues by double-clicking on the queue or by 
clicking once to select the queue and then choosing an option from the Queue menu.

Journals

Journal files are listed in their respective queues. You can stop printing a journal file, place the file on 
hold, delete the file, or re-queue the file for later printing. To do this, double-click on the file or click once to
select the file and choose the appropriate option from the Document menu.

See also

View menu, Options menu, Help menu



Queues

A queue is a list of journal files currently printing or waiting to print.    Queues are always associated with a
print device and can be local to the workstation or remote (directed across a network to another    
workstation).

An icon representing your print device is displayed against the queue.    When you hold a queue, journal 
files will not be printed but will wait until the queue is released.    The EPSON Spool Manager places a 
wait symbol against the icon when the queue is on hold.



Queue Menu

The options on the Queue menu allow you to place EPSON Stylus print queues on hold, release them for 
printing, and identify them as local or remote queues for network printing. Follow the steps in the sections 
below to use the options.

Holding or Releasing a Queue

Click the queue and select the Hold option on the Queue menu. A check mark beside the Hold option 
indicates the queue is on hold. The Spool Manager also places a wait symbol beside the printer icon 
associated with the queue. Journal files in the queue are not submitted for printing. To release the queue, 
click the queue again; the check mark disappears.

Scheduling Print Jobs with the Windows Print Manager

The EPSON Despooler normally prints directly to the printer. If you are using a network or wish to 
schedule print jobs using the Windows Print Manager instead, follow these steps:

1. Double-click the name of the queue you want to direct; you see the Queue Setup dialog box. (You
can also click the queue and select Setup from the Queue menu.)

2. Click the Use Print Manager for this port box; then click OK.

Printing on a Network

The EPSON Stylus series printer driver allows you to send journal files from your workstation (Host) to a 
shared directory on a network server. These files can then be printed by another workstation (Remote) 
that is also set up to run the EPSON Spool Manager and the EPSON Stylus series printer driver. Follow 
the steps below to send journal files from either a Host or Remote workstation:

Host Setup

1. Double-click the name of the queue you want to direct; you see the Queue Setup dialog box. (You
can also click the queue and select Setup from the Queue menu.)

2. Select the Spool to remote printer option.

3. Click the Browse button. You see the Spool Directory dialog box.

4. Select the spool directory on the remote server to which you want to send journal files from the 
Spool Manager.

Remote Setup

1. Double-click the name of the queue you want to direct; you see the Queue Setup dialog box. (You
can also click the queue and select Setup from the Queue menu.)

2. Click on the Remote Despool tab.



3. Click the Printing from remote queues box.

4. Click the Browse button. You see the Remote Spool Directory dialog box.

5. Select the spool directory on the remote server to which you want to send journal files from host 
workstations.

Note:
This feature is quite different from the remote printer spooling provided by most network operating 
systems. Redirect the printer LPTx: ports in the usual manner to use your networks features. You may 
also need to enable the Windows Print Manager (as described above) on some network operating 
systems when you use port redirection.



Document Menu

The Document menu allows you to control journal files in the EPSON Stylus series printer queue(s). 
Journals can be held, re-queued for later printing, deleted, or kept for subsequent reprinting. Double-click 
the journal file and select the option you want from the journal files dialog box. (You can also click the 
journal file and select the option you want from the Document menu.)



View Menu

The View menu allows you to limit the amount of information given about queues and journal files in the 
EPSON Spool Manager. You can also control display of the EPSON Despooler that pops up when you 
print.

Check marks next to the Show Status, Show Size, and Show Time/Date options indicate the information 
is displayed in the Spool Manager window. 

A check mark beside the Show Despool Popup option indicates that the EPSON Despooler pops up 
whenever you print; click this option to disable the pop-up feature. (The EPSON Despooler still pops up if 
there is a printer error.)



Options Menu

The Options menu controls the default spool directory, the timer, and the font selections as described 
below.

Default Spool Directory

Select this option to change the directory in which the driver will send journal files. The predefined 
directory is TEMP. This option is similar to changing the spool directory using the Setup option in the 
Queue menu, except the new directory applies to all queues, not just the selected queue.

Timers

The Update Timer tells the Spool Manager how often to refresh the information displayed in the Spool 
Manager window. Change the default refresh time to the desired number of seconds.

The Remote Timer tells a remote Spool Manager how often to look for new journal files in network 
directory. Change the default time to the desired number of seconds. (See Queue Menu for more 
information about network printing.)

Font

This option allows you to change the default font, font style, and point size used to display information in 
the Spool Manager window.



Help Menu

The Help menu lets you access the EPSON Spool Manager help utility (Help option) and view copyright, 
trademark, and version information on the Spool Manager (About option).



EPSON Despooler

When the EPSON Spool Manager processes a journal file, it submits the file to the EPSON Despooler. 
The Despooler window pops up on your screen to show the progress of the current print job and display 
additional printer status information.

Note:
If you turned off the Show Despool Popup option in the View menu of the EPSON Spool Manager, the 
Despooler window only appears if there is a printer status error.

On the right side of the Despooler window is a box containing one or more horizontal bands that 
represent a division of the current page being printed. The Despooler sends the page to the printer one 
band at a time.

Status messages and symbols representing error conditions may be displayed on the image of your 
printer located on the left side of the Despooler box. When you correct an error condition, such as loading
paper when the printer was empty, the Despooler detects the new condition and continues printing. If a 
serious error occurs, such as a printer power failure, you must resend the print job to print it again.

You can also use the Despooler to control journal files (just like the Document option in the EPSON Spool
Manager) by clicking these buttons:

 Stop 

 Pause 

 Rewind 

Select the Help button to use the Despooler help utility and the About button to view copyright information 
on the Despooler.



Questions and Answers

Read the following questions and answers to learn more about the EPSON Stylus series printing system:

Q. Do I need to change the options in the printer driver?

A. Not really. The printer driver includes an Automatic Document Type option that sets various image
settings for you as appropriate for each page of your document. Also, the default printer driver 
settings are pre-set to the most useful options for most printing needs. You probably do need to 
indicate the type of paper or other media you have loaded by selecting the Printing Mode/Options
tab and identify the paper size by selecting the Paper tab.

Q. What does the Defaults button do?

A. Selecting this button returns all the printer driver settings to the programs predefined options.

Q. I have selected a diffusion option but my printed image does not look diffused. Why?

A. Your application software has a setting that is overriding the drivers halftone setting. Check your 
software for an option that allows you to use the drivers halftone control instead.

Q. No matter which halftone method I choose, the printed image looks the same. Why?

A. Your application software has a setting that is overriding the drivers halftone setting. Check your 
software for an option that allow you to use the drivers halftone control instead.

Q. I cannot print to a Windows remote printer from Windows for Workgroups or LAN setup software. 
Why?

A. You need to direct the EPSON Spool Manager to print through the Windows Print Manager. You 
do this by selecting the printer queue you wish to direct on the Queue menu and then selecting 
the Use Print Manager for this port option.

Q. I am using an NEC® PC-98 series computer and cannot print to the LPT or COM port from the 
EPSON Stylus series printing system. Why?

A. You may need to direct the EPSON Spool Manager to print through the Windows Print Manager. 
You do this by selecting the printer queue you wish to direct on the Queue menu and then 
selecting the Use Print Manager for this port option.



Q. I cannot print from a Windows session running under OS/2™ . Why?

A. You may need to direct the EPSON Spool Manager to print through the Win-OS/2 Print Manager. 
You do this by selecting the printer queue you wish to direct on the Queue menu and then 
selecting the Use Print Manager for this port option.

Q. Can I send journal files to a remote EPSON Spool Manager across my network?

A. Yes. See the description of this procedure in the Queue Menu topic.



Quick Tour

The following Quick Tour gives you a brief look at the features and capabilities of the EPSON Stylus 
series printer driver.

To view the driver, you can select it from your applications Print Setup menu (or Print and then Setup), or 
you can select it using the Windows Control Panel Printers option.

There are six tabs containing related printer driver settings:

Document Type

Select the Document Type tab to select the type of document you will print and to choose either 
monochrome or color printing. For best results, leave the Document Type option set to Automatic so the 
printer driver can automatically adjust various printer driver settings for you on a page-by-page basis.

Paper

Select the Paper tab to identify the size of the paper you loaded and the orientation you want for the 
image on the page. As you scroll through the paper sizes, an example displays the paper dimensions and
the printable area. Click either Portrait or Landscape to change the orientation.

Printing Mode/Options

Select the Printing Mode/Options tab to define the Printing Mode (resolution) in which you want to print, 
the Media Type you loaded in the printer, and the MicroWeave and High Speed mode options. The Media 
Types listed depend on the Printing Mode you select, and the MicroWeave and High Speed mode print 
options are set automatically based on the selection of both the Printing Mode and Media Type. You may 
also be able to change the default Print Option settings.

Image Settings

Select the Image Settings tab to choose various settings that affect the color, brightness, and clarity of 
your image. A sample image on the dialog box changes to reflect the selected settings, and you can also 
select a different sample image, if you wish. The printer drivers Automatic Document Type option 
automatically sets the image settings for you and it is best to leave the settings at the automatic 
selections.

Halftoning

Select the Halftoning tab to choose the halftoning or diffusion method for your printed image. A sample 



image on the dialog box changes to reflect the selected setting. The printer drivers Automatic Document 
Type option automatically sets the halftoning method for you and it is best to leave the setting at the 
automatic selection.

About

Select the About tab to view information about your version of the printer driver in case you need it when 
contacting technical support.



Copyright and Trademark Information

The EPSON Stylus series printing system is a development of Software 2000 Ltd., Oxford, England.

Portions Copyright © 1994,1995 Seiko Epson Corporation

Copyright © 1994,1995 Software 2000 Ltd., Oxford, England

All rights reserved.

All other trademarks of their respective owners are recognized. EPSON disclaims 
any and all rights in those marks.



OK Button

The OK button saves any changes you have made to the printer driver settings and closes the printer 
driver. You can select the OK button in three ways:

Click the mouse on the button

Press the Enter key when the button is highlighted

Press and release the space bar when the button is highlighted.



Cancel Button

The Cancel button closes the printer driver without saving any changes you may have made to the 
settings. You can select the Cancel button in four ways:

Click the mouse on the button

Press the Esc key

Press the Enter key when the button is highlighted

Press and release the space bar when the button is highlighted.



Defaults Button

The Defaults button restores all of the printer driver settings to their factory defaults. Use this button if you
have made changes to the default settings but want to return them to their original options. You can select
the Defaults button in three ways:

Click the mouse on the button

Press the Enter key when the button is highlighted

Press and release the space bar when the button is highlighted.



Document Type

Select a document type that most closely matches the type of document you will be printing or let the 
printer driver select it automatically.

Automatic is the default setting and produces the best printed results. This setting lets the printer driver 
analyze the data on each page of a document and adjust the Printing Mode (resolution), Color Matching, 
and Halftone settings automatically. The driver selects the printing mode and halftoning settings based on
the data contained in each entire page, but selects the color matching setting based on each object on a 
page, such as each graphic or block of text.

If you prefer to set the document type manually, follow these guidelines:

Select Presentation when you are printing documents containing many graphic elements, such as
charts in presentations

Select Photograph when you are printing photographs 
Select Drawing when you are printing computer-generated illustrations
Select Text when you are printing documents containing only text.

Each of the manually set document types select predefined settings for Color Matching and Halftone. If 
you change a predefined Halftone or Color Matching setting, the driver erases the selected document 
type and uses the new settings you selected.

See also

Ink , OK Button, Cancel Button, Defaults Button 



Printing Mode

Specifies the resolution to be 720 dpi, 360 dpi, or 180 dpi. Resolution is the amount of detail used to 
create an image. The higher the resolution, the sharper and finer the image.

For the best possible resolution, choose Super - 720 dpi resolution. When you select this resolution, 
MicroWeave is automatically turned on and High Speed mode is turned off. For best results at 720 dpi, 
load Special coated paper (or index cards) for 720 dpi or High-quality glossy paper.

For most color printing, select Best - 360 dpi resolution. This resolution produces good-quality, full-color 
images using less memory and in less time than 720 dpi. For best results at 360 dpi, use EPSON Special 
coated paper for 360 dpi.

When speed is important and draft quality is good enough, use Draft - 180 dpi resolution.

Note:
Printing at lower resolutions also conserves ink.

See also

Media Type, Print Options



Media Type

Sets up the printer for the type of paper you loaded. Depending on your Printing Mode setting, Media 
Type can be one of the following:

Plain paper

You can use most plain paper with your printer and achieve good results. Coated papers give you better 
results because they reduce the amount of ink that is absorbed. However, if the coated paper does not 
absorb enough ink, the ink can smear. To ensure the best results, EPSON provides special papers and 
transparencies that are formulated for the inks used in EPSON ink jet printers.

Special coated paper for 360 dpi

Use this paper for best results when printing at 360 dpi.

Special coated paper for 720 dpi

Use this paper for best results when printing at 720 dpi. Five sample sheets are included with the printer.

Use EPSON Special coated index cards for 720 dpi for sharp, clear results when printing on index cards 
at 720 dpi. For best results, use the cards within one year of purchase.

High-quality glossy paper

Use this paper with 720 dpi to produce camera-ready composites. When printing on glossy paper, use 
only EPSON High-quality glossy paper. 

Transparency

When printing transparencies, use only EPSON transparencies. For best results, use transparencies 
within six months of opening the package. Do not use 720 dpi when printing transparencies.

See also

Printing Mode, Print Options



Print Options

Allows you to turn the MicroWeave and High Speed mode settings on or off.

MicroWeave reduces the possibility of banding, the light horizontal lines that can mar an image. When 
you turn on MicroWeave, the printer produces superior output because graphics data is reordered and 
printed in fine increments. It slows the print speed but is recommended for printing color and grayscale 
images. Because it does not improve the print quality for text and line art, turn it off to print these kinds of 
images faster.

When you turn on High Speed mode, the printer uses bidirectional printing, reducing the time it takes to 
print an image. Bidirectional printing is fast, but for highest quality, always turn off High Speed mode.

Note:
If the vertical lines appear misaligned when you print using High Speed mode, calibrate the printer as 
described in your Users Guide.

See also

Printing Mode, Media Type



Color Matching

Controls the printer's color ink correction features based on the selected Document Type. Color Matching 
is automatically set to the most appropriate setting when you select a particular document type or use the 
Automatic setting. It is best to leave Color Matching set to the driver's selection.

The settings perform the following functions:

Off turns off color matching so you can use your application program's color correction features.

Vivid intensifies the colors while lightening the midtones and highlights of an image in documents such as
presentation graphics and charts.

Photo-realistic increases the contrast in images such as color photographs.

Standard adjusts colors so they closely match the original screen colors in images such as illustrations.

 




